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INTRODUCTIE MASTERCLASS

Welkom bij de masterclass Game Development. In deze masterclass geven we een introductie over
game development.

Bij het ontwerpen en creéren van games komt veel kijken: level design, character modeling,
programmeren, visual arts, geluid en noem maar op. In deze masterclass zullen we beginnen met basic
level design en met name textures en objecten maken.

Zoals je misschien al weet gaan we werken met het spel Half-Life 2. Dit is een first-person-shooter
gebouwd op de geavanceerde Source Engine. Deze engine staat bekend om zijn geweldige ingebouwde
physics. Mede hierdoor hebben we voor Half-Life 2 gekozen. Bovendien is het ook mogelijk om je eigen
mod(ification)s te maken. Het bekende Counter-Strike is een voorbeeld van zo een mod. Een ander
voorbeeld is VU-Life 2, een mod met elementen uit de VU. Deze mod gaan we gebruiken voor
demonstraties.

In deze masterclass geven we je een overzicht van de geschiedenis van spellen, vertellen we je over wat
er komt kijken bij het maken van een spel en mag je zelf aan de gang met de volgende onderwerpen:

Experimenteren met het toevoegen van textures aan objecten
Het uiterlijk veranderen van een model van Half-Life 2

Basis objecten maken in een level

Bestaande effecten aanpassen

Nieuwe effecten toevoegen aan een level

Veel succes!

Het Masterclass Game Development team
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LES 1: DE GESCHIEDENIS VAN COMPUTERSPELLEN EN HET MAKEN VAN
SPELLEN

DE GESCHIEDENIS VAN SPELLEN

Welkom bij de geschiedenis van computerspellen. Wist je dat computerspellen meerdere malen gezorgd
hebben voor een kleingeldtekort in Japan? Of dat het eerste computerspel al meer dan 40 jaar geleden
is gemaakt? Deze en andere leuke of interessante weetjes vind je hier.

Er was eens... Of nou ja, eigenlijk was het niet zo duidelijk wat nou het eerste spel was. In 1951 krijgt
Ralph Baer de opdracht om "het beste tv-toestel ter wereld" te bouwen. Zijn suggestie is om een soort
interactief spel toe te voegen aan dit tv-toestel. Maar zijn idee wordt genegeerd. Pas in 1967 wordt zijn
idee werkelijkheid als Bear meehelpt met het bouwen van de Magnavox Odyssey. In de tussentijd heeft
in 1958 William Higinbotham het spel Tennis for Two gemaakt, als leuk onderdeel van een open dag van
het laboratorium waar hij werkt. In 1961 maakt Steve Russel ook een spel: Spacewars!. Zowel
Higinbotham als Russel hebben beiden niet het idee iets bijzonders gemaakt te hebben en vragen dan
ook geen patent aan. Ralph Bear doet dit wel en officieel heeft hij dus het eerste spel gemaakt. De
meningen verschillen over of hij nou werkelijk de eerste was, maar in ieder geval was hij de eerste die
met het idee kwam.

Gelijk met de ontwikkeling van spellen komt de markt voor spelautomaten op. Hiervan verschijnt in
1971 de eerste, gemaakt door Nolan Bushnell. Dit was geen succes. Bushnell is nog steeds overtuigd van
zijn plan en daarom richt hij Atari op. De tweede automaat is het spel PONG, gemaakt door Atari en dit
is wel een grote hit. In eerste instantie zijn het vooral spelautomaten waarop nieuwe spellen
verschijnen, omdat goede thuissystemen nog niet haalbaar zijn. Klassiekers als Space Invaders,
Asteroids, Pac-Man, Donkey Kong, Pole Position en Street Fighter Il kwamen voor het eerst op de
spelautomaten uit en werden zeer fanatiek gespeeld in hun tijd. De spellen die op de spelautomaten
uitkwamen zijn vaak later geconverteerd naar thuissystemen, sommigen wat minder goed dan anderen.

Begin jaren '80 komt de Laser Disc op. De Laser Disc biedt de mogelijkheid om veel meer data op te
slaan en hierdoor is een interactief verhaal als Dragon's Lair mogelijk. Het zat deze nieuwe technologie
helaas niet mee.

Tot aan 1983 gaat alles erg goed met de computerspellenmarkt. Er zijn vele verschillende
thuiscomputers op de markt, spelautomaten zijn razend populair, er lijkt geen eind aan te kunnen
komen. Helaas blijkt dit toch te kunnen. In 1984 zijn er teveel producten op de markt en stort de hele
boel in elkaar. Veel kleinere bedrijven gaan failliet en ook de grotere hebben het moeilijk door grote
hoeveelheden niet verkochte producten.

In 1985 begint de industrie weer langzamerhand op te krabbelen na dus flink onderuit te zijn gegaan.
Voornamelijk Tetris is populair in deze tijd. In 1985 begint Nintendo ook te testen met zijn nieuwe
systeem, het Nintendo Entertainment System (NES).

De NES is een groot succes en in 1986 wordt hij op de markt gebracht met als introductie spel Super
Mario Bros.. Voor Nintendo volgden er nog vele hits op hun NES, zoals The Legend of Zelda en Final
Fantasy. Naast het grote succes van de NES is ook de Game Boy een grote hit. De mogelijkheid om
spellen overal waar je maar wil te kunnen spelen spreekt iedereen aan. Veel van de spellen voor de NES

r@
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komen ook in aangepaste vorm uit op de Game Boy. Een grote hit speciaal voor de Game Boy is de
Pokémon reeks.

SEGA, Nintendo's grootste concurrent zit niet stil tijdens dit alles. Ze besluiten hun eigen mascotte te
lanceren om te concurreren met Mario. Dit wordt Sonic the Hedgehog. Helaas krijgt SEGA het niet voor
elkaar om te blijven concurreren met Nintendo. In 2001 gooit SEGA de handdoek in de ring en stopt met
het produceren van spelcomputers. Wel gaat het door met het produceren van software en
spelautomaten en zo kan het gebeuren dat je nu Sonic aan kunt treffen op Nintendo systemen.

De ontwikkelaars van personal computers hebben ondertussen ook niet stil gezeten en voor dit systeem
is veel gebeurt sinds Spacewars!. In het begin waren de spellen simpel en veelal text-based. Spellen als
King's Quest en Leisure Suit Larry zijn hierom erg bekend. Ook waren er veel spellen gebaseerd op
populaire spelautomaten en waren spellen waarin je een sport beoefend zoals Summer Games in het
begin erg populair, al komen deze nu meer voor op de spelcomputers. In 1989 kwam er een uniek en
nieuw spel uit voor de PC, namelijk SimCity. Simulatoren zijn sindsdien een populair genre op de PC; zo
kan je zelfs een hele familie besturen in The Sims. De PC wordt gezien als meer volwassen dan de
spelcomputers en hier komen dan ook meer volwassen spellen voor uit, zoals Doom, Tomb Raider en
Carmageddon.

Hoewel de PC altijd zich toch het meest op volwassenen gemikt heeft zie je ook bij de spelcomputers
verschillen tussen de leeftijden waar meestal op gemikt wordt. De Playstation 3 en Xbox 360 mikken
traditioneel meer op oudere spelers, terwijl de Wii juist meer gaat voor de jongere. Dit wil natuurlijk niet
zeggen dat er op deze spelcomputers echt alleen spellen uitkomen voor deze leeftijdsgroepen.

De laatste tijd zijn er weinig echt vernieuwende en innovatieve spellen te vinden. Fabrikanten zijn nu
vooral bezig alles mooier te maken, allemaal nieuwe snufjes toe te voegen en de gameplay te
verbeteren. Veel van de spellen die nu uit komen zijn niet duidelijk anders dan oudere spellen, alleen
maar veel mooier en vaak ook online te spelen. Online spelen zelf is een van de belangrijkste
ontwikkelingen van de laatste tijd en veel spellen en alle spelcomputers voor thuis die nu uitkomen
ondersteunen het. Andere recente ontwikkelingen zijn gemaakt op het gebied van hoe spellen worden
bestuurd, zoals met stemherkenning, de EyeToy en de Wii-mote. Het is te verwachten dat fabrikanten
op hetzelfde pad door zullen gaan en om de zoveel tijd zullen nieuwe, innovatieve spellen uitkomen.

Het is lastig om nu in te schatten wat de belangrijkste spellen van onze tijd zullen zijn, vandaar dat dit
overzicht slechts tot 2000 loopt. Daarnaast is het onmogelijk om een volledig overzicht van alle spellen
te maken die ook maar een beetje populair zijn geweest, vooral ook omdat sommige spellen alleen
binnen bepaalde groepen populair waren. Om deze redenen biedt dit overzicht slechts een kleine greep
uit alle spellen die hier vermeld hadden kunnen worden. Dit zijn wel allemaal spellen die behoren tot de
belangrijksten in hun tijd en genres.

VooRr 1970

De Tweede Wereldoorlog geeft een enorme impuls aan het maken van computers. Geheime codes die
de verschillende partijen moeten ontcijferen kosten namelijk veel rekenwerk en rekenen is iets waar
computers uitermate goed in zijn. Sindsdien ontwikkelt de computer zich steeds verder. De eerste
computers hadden bijna een klein huis nodig aan ruimte, maar langzamerhand worden de computers
kleiner en wordt de rekenkracht groter.
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De eerste bug (nu bekend als een fout in een programma of computer) die ooit veroorzaakt werd in
1945, was veroorzaakt door een echte "bug": een mot vioog naar binnen bij een van de eerste
computers en kwam vast te zitten in het systeem. De computer liep hierdoor vast, maar nadat de mot er
uit was gehaald werkte hij weer. Hier komt de term "debugging" dan ook vandaan. Een ander
interessant feit is dat er in 1955 244 computers in de Verenigde Staten waren, samen hadden deze
computers minder rekenkracht dan een kleine computer in 1980.

Met de grote ontwikkelingen op computergebied zijn opeens veel meer dingen mogelijk. In 1958 wordt
het eerste spel gemaakt, maar dit werkt nog volledig hardwarematig. In 1961 is het eerste spel op een
computer een feit.

Tussen 1960 en 1970 worden veel ontwikkelingen gedaan. In 1962 krijgen de Amerikanen het voor
elkaar door alle nieuwe ontwikkelingen op computergebied hun eerste astronaut de ruimte in te krijgen
en in 1969 land de eerste man op de maan. Verder is in 1968 de eerste spelcomputer voor thuis
werkelijkheid. Ook is de eerste spelautomaat in ontwikkeling, hoewel deze pas later in de
automatenhallen te vinden zal zijn.

Belangrijke data:

e 1889 oprichting Nintendo.

e 1891 oprichting Philips.

e 1947 oprichting Sony.

e 1951 de eerste commerciéle computer komt op de markt, dit is de UNIVAC I.
1951 Ralph Baer komt met het idee om een spel in te bouwen in een televisie.

e 1954 oprichting SEGA.

e 1958 William Higinbotham maakt Tennis for Two.

e 1961 Steve Russel maakt Spacewar!.

e 1968 een patent wordt aangevraagd op Baer's interactieve televisie.
1970 - 1980

De trend in computers om alles steeds kleiner en sneller te maken zet zich door. Gordon Moore ziet dit
en doet in 1973 de voorspelling dat elke 1.5 jaar het aantal transistors op een computer chip zal
verdubbelen. Ruim 20 jaar later gaat zijn voorspelling nog steeds op. Eind jaren '70 beginnen de
thuiscomputers op te komen.

In 1970 wordt een volledig geautomatiseerde supermarkt opgezet. De vraag is zo groot dat de
supermarkt het niet bij kan benen en uiteindelijk gaat de supermarkt hieraan ten onder. Wanneer in
1976 een computerspel gebaseerd op de film Deathrace 2000 uitkomt, is dit het eerste spel dat om
morele redenen verboden wordt. Het was in dit spel de bedoeling om punten te halen door mensen
omver te rijden. Jaren later zal het spel Carmageddon dat hetzelfde principe bevat ook nog voor veel
discussie zorgen. Bij eerdere computer spellen wordt vaak niet vermeld wie het spel gemaakt heeft.
Sommige programmeurs zijn het hier niet mee eens en beginnen stiekem hun naam te verstoppen in
hun spellen.

Steve Jobs en Steve Wozniak die later Apple op zullen richten werkten eerst voor Atari. Voor Atari
maakten zij het spel Breakout, wat uiteindelijk het beste spel van 1976 wordt. Hoewel Jobs zo ongeveer
$5.000 ontvangt hiervoor, vertelt hij Wozniak dat het slechts $700 was. Wanneer Jobs en Wozniak hun
eerste reeks computers maken doen ze dit voor een groot deel met van Atari "geleende" onderdelen.
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Atari zelf is ook in deze tijd opgericht, net als Microsoft. Microsoft is nog steeds een van de belangrijkste
spelers op de markt, Apple doet ook nog goed mee. Atari is tegenwoordig uitgever van spellen.

Belangrijke data:

e 1970 het eerste portable computerspelletje (Game & Watch) wordt door Nintendo uitgebracht.
e 1971 de eerste computergestuurde speelautomaat verschijnt in de automatenhallen.

e 1972 de eerste e-mail wordt verzonden.

e 1972 de cd wordt uitgevonden.

e 1972 oprichting Atari.

e 1975 geldautomaten worden geintroduceerd.

e 1975 oprichting Microsoft.

e 1975 de eerste draagbare computer is een feit, dit is een voorloper van de laptop.

e 1976 oprichting Apple.

1980 - 1990

Het wordt steeds betaalbaarder voor mensen om zelf een computer te hebben. In 1980 zijn wereldwijd
ongeveer 724.000 thuiscomputers in gebruik. Begin jaren '80 is de VCS van Atari (die al in 1977 uit
kwam) de belangrijkste spelcomputer. Halverwege de jaren '80 krijgt Nintendo een groot deel van die
markt in handen met de NES terwijl het langzaam aan slechter met Atari begint te gaan.

Voor 1984 lijkt echt alles te kunnen, maar dan blijkt dit toch niet helemaal waar te zijn. Een begin van de
problemen is te zien als Commodore $100 korting geeft op een systeem van hen bij het inleveren van
een ander systeem. Competitie die systemen aanbiedt voor onder de $100 worden zo heel handig uit de
markt gedrukt. Dit werkt omdat deze systemen tegen minder dan de kostprijs aangeboden worden, met
het idee winst te maken op de Commodore software. Ook veel grotere bedrijven komen in de
problemen. Zo wordt onder andere het personeelsbestand Atari halverwege de jaren '80 teruggebracht
naar minder dan 7% van wat het was op het toppunt van het bedrijf. Dit werd gedaan in een poging om
de kosten naar beneden te krijgen. Dit was succesvol en Atari kon het nog een aantal jaar langer vol
houden.

Computers worden ondertussen op steeds meer gebieden toegepast. Michael Jackson laat met zijn
Victory tour in 1984 zien dat computers enorm kunnen helpen voor een mooie show. Bij zijn optreden
worden 6 computers gebruikt voor de bediening van licht, geluid en een robotspin. Tot deze tijd werden
computers niet op deze schaal gebruikt bij optredens. Ook James Bond haakt in op het hele computer
fenomeen. In de film “A View To A Kill” moet James Bond een nieuwe computerchip terugvinden die de
Russen gestolen hebben. In Frankrijk automatiseert de politie zijn systeem om aanklachten rond te
sturen. In 1989 gaat hier iets mee mis en krijgen 41.000 inwoners van Parijs aanklachten voor moord,
afzetting of prostitutie op de mat in plaats van verkeersboetes. Het gebruiken van computers gaat dus
niet altijd goed.

Belangrijke data:

e 1980 een computer verslaat voor het eerst een schaakgrootmeester; hierbij moet vermeld
worden dat de grootmeester tegen 26 mensen tegelijk aan het spelen was waarbij 3 mensen
instructies kregen van computers.

e 1981 Xerox komt als eerste met het idee van de computermuis.

e 1981 de eerste vrouwelijke computerspeldesigner levert haar eerste spel af.

e 1982 ervalt voor het eerst een dode bij het spelen van een computerspel.
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e 1983 afgesproken wordt dat TCP/IP het standaard protocol voor Internet wordt.

e 1983 Windows wordt aangekondigd.

e 1985 de eerste versie van Windows komt daadwerkelijk uit.

e 1986 Nintendo komt met de NES, een revolutionaire thuiscomputer gebaseerd op het Famicom
systeem dat in 1984 al in Japan uitkwam.

1990 - 2000

In dit decennium zien we de opkomst van een nieuwe generatie spelcomputers en het Internet. De
nieuwe spelcomputers zijn sneller, genereren mooiere beelden en hebben veel extra's. Vaak hebben
deze nieuwe spelcomputers ook de mogelijkheid om het Internet op te gaan. Op deze manier kun je
tegen mensen over de hele wereld spelen. Helaas heeft het Internet niet alleen voordelen; zo kunnen
computervirussen zich makkelijk verspreiden via het Internet en zorgen dan ook voor veel schade in
deze jaren.

Tegen het eind van het decennium begint een probleem te ontstaan. Oude computerprogramma's slaan
data op met 2 cijfers voor het jaar, om ruimte te besparen. Bij de eeuwwisseling verandert (19)99 dus in
(20)00. Er wordt gevreesd dat veel oude programma's 00 niet zullen interpreteren als 2000, maar als
1900, waardoor heel veel dingen mis zouden kunnen gaan. In de laatste jaren van deze eeuw wordt veel
tijd en geld besteed aan het oplossen van deze zogenaamde millennium bug en uiteindelijk valt de
schade erg mee.

Op de Olympische Zomerspelen van 1996 zou IBM de computers regelen om het geheel te
ondersteunen. IBM heeft een aantal beloftes gemaakt en zou belangrijke klanten van alles laten zien.
Uiteindelijk zijn er veel problemen, moeten een hoop dingen met de hand gedaan worden en zijn de
systemen vaak down. Zelfs met 3 jaar voorbereiding blijkt een groot bedrijf als IBM zoiets groots als de
Olympische Spelen niet goed te kunnen regelen.

De computer Deep Blue wint het eerste potje van een beste van de 6 schaakwedstrijd tussen de
computer en Garry Kasparav. Het tweede potje is voor Kasparav, waarop 2 potjes volgen waar geen
winnaar uit komt. Het 5e potje wint Kasparav weer en ook het laatste beslissende potje wint hij. Mens
wint nog steeds van de machine. Een paar jaar later zal Deep Blue wel winnen.

In 1998 wordt een chat georganiseerd met Koko, een 26 jaar oude vrouwelijke gorilla. Deelnemers
stellen vragen die vertaald worden naar gebarentaal. Koko's antwoorden worden terug vertaald en
terug gestuurd naar de chatters.

Belangrijke data:

e 1991 de SNES wordt uit gebracht.

e 1993 prototypes van de eerste PDA's worden getoond.

e 1994 de eerste harde schijf met 1 gigabyte aan ruimte komt uit.

e 1994 de eerste computers die sneller gaan dan 100 MHz komen op de markt.
1994 de Playstation wordt uit gebracht.

1995 Windows 95 komt uit.

1995 de Sony Playstation is te koop.

1995 E-Bay start.

1996 Atari wordt opgeheven.

e 1996 De Nintendo 64 komt uit na al in 1993 aangekondigd te zijn.
e 1998 SEGA brengt de Dreamcast op de markt.
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2000 EN LATER

De ontwikkelingen bij de spelcomputers gaan door. Sony komt met de Playstation 2, Nintendo met de
GameCube en ook Microsoft stort zich op de markt met de Xbox. De nieuwe spelcomputers doen niet
onder voor thuiscomputers van slechts enkele jaren eerder. Ingebouwd in de spelcomputers zitten
harde schijven en modems om via het Internet te kunnen spelen. Er kan verwacht worden dat de markt
voor spelcomputers nog lang zal blijven bestaan, waarbij waarschijnlijk uiteindelijk de spelcomputers
steeds meer weg gaan hebben van gewone computers.

Naast de spelcomputers voor thuis vinden er ook ontwikkelingen plaats op het gebied van
spelcomputers die je zelf mee kunt nemen voor onderweg. Nintendo heeft niet stil gezeten met de
ontwikkeling van zijn Game Boy, met ondertussen kleurenversies en extra processorkracht die er voor
zorgen dat het spelen van SNES spelen al gemakkelijk haalbaar is. Op dit gebied komt er ook een nieuwe
ontwikkeling op, mensen krijgen namelijk steeds geavanceerdere mobiele telefoons. Waren een paar
jaar geleden zwart-wit schermen en heel simpele spelletjes de norm, ondertussen hebben mobieltjes
kleurenschermen van een behoorlijke grootte, ingebouwde camera's en processors die dit alles aan
kunnen. De spelletjes die nu op mobiele telefoons gespeeld kunnen worden doen al niet zo heel veel
meer onder voor die op de Game Boy.

Voor de mensen met een gewone computer met Internetverbinding zijn er vele gratis spelletjes online
te vinden. Vaak zijn deze spelletjes ook tegen anderen te spelen. Ook komen er steeds meer spellen bij
die massaal te spelen zijn via het Internet. Voor sommige van deze spellen log je in op een wereld met
duizenden mensen tegelijk, waarbij de wereld gewoon door draait als jij er weer af gaat. Het is
waarschijnlijk dat het Internet alleen maar meer mogelijkheden gaat bieden voor het spelen van spellen.

Omdat het steeds makkelijker wordt om thuis spelletjes te doen, neemt de populariteit van de
spelautomaat de laatste jaren gestaag af. Veel belangrijke producenten van spelautomaten stoppen dan
ook met het produceren van deze automaten. Waarschijnlijk liggen de mogelijkheden voor de
spelautomaten vooral bij het integreren met spelcomputers, waardoor spellen zowel voor de
automaten als voor de spelcomputers gemaakt kunnen worden.

LINKS

The Dot Eaters: Classic Video Game History (Engelstalig) (http://www.thedoteaters.com/) - The Dot
Eaters is een zeer uitgebreide site die vooral focust op de begintijd van de computerspellen, ongeveer
tot halverwege de jaren 80. Veel van de weetjes over de eerdere spellen komen van deze site.

GameSpot presents: The History of Video Games (Engelstalig)
(http://www.gamespot.com/gamespot/features/video/hov) - Gamespot biedt een overzicht van de vele
belangrijke gebeurtenissen in de geschiedenis van videospellen. Ook wordt veel informatie
weergegeven over de situatie om de games zelf heen. De informatie op deze site loopt ongeveer tot
2001.

Wikipedia (meerdere talen) (http://www.wikipedia.org/) - Wikipedia is een van de meest uitgebreide
encyclopedieén op het Internet. Wanneer je informatie zoekt over een specifiek spel, is dit een van de
beste plekken om te kijken. Doordat iedereen bij kan dragen aan deze encyclopedie is de informatie die
je vindt niet altijd even goed, maar zolang je hier rekening mee houdt hoeft dit geen probleem te zijn.
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ICWhen (Engelstalig) (http://www.icwhen.com/) - ICWhen biedt een uitgebreid overzicht van de
ontwikkelingen van computerhardware in de loop van de tijd. Ook vind je er veel over software, zoals
wanneer bepaalde spellen uitkwamen en door wie ze uitgegeven werden.

HET MAKEN VAN EEN SPEL

Er is één ding dat aan de basis staat van elk spel: het idee. Zonder een goed idee ben je nergens. Je spel
staat of valt met het idee. Dit idee moet genoeg zijn om andere mensen enthousiast te maken voor
jouw spel. Wat je dus wilt doen is dit idee goed uitleggen in een beschrijving van wat het idee achter het
spel is, waarom mensen dit zo leuk zouden moeten gaan vinden en wat de doelgroep is.

Met je beschrijving ga je naar een bedrijf toe dat spellen maakt, of, als het even kan werk je daar al en
ga je gewoon naar je baas toe. Je missie is nu om anderen warm te maken voor jouw spel. Een bedrijf als
dit krijgt met enige regelmaat nieuwe ideeén binnen en je moet zorgen dat de jouwe uitspringt tussen
de rest. Als alles goed gaat overtuig je aan de hand van je beschrijving en je eigen uitleg de mensen van
het bedrijf. Deze zorgen nu dat er geld beschikbaar komt om mee verder te werken.

Je eerste taak is nu om het spel verder te ontwerpen. Hoe werken dingen precies, wat zijn de regels van
het spel, wanneer win je het spel, etc. Probeer hierbij genoeg andere mensen je ontwerp te laten lezen
en gebruik vooral hun commentaar voor verbeteringen. De kans is klein dat jij de enige bent met goede
ideeén. Wanneer je denkt dat er geen verbetering meer mogelijk is maak je je uiteindelijke ontwerp. Dit
ontwerp leg je voor aan je bazen en wanneer deze ook hiervan onder de indruk zijn kun je verder gaan.

Je gaat nu specifieker uitleggen hoe de dingen die je verzonnen hebt geimplementeerd moeten worden.
Denk hierbij bijvoorbeeld aan wat voor muziek nodig is, wat voor animaties, wat voor algoritmes je
nodig hebt (stukjes programmeercode die iets specifieks doen) en wat voor budget je nodig hebt.

Een ander belangrijk onderdeel dat nu gemaakt moet worden is de "graphic bible". Dit document bevat
een beschrijving en uitwerking van hoe onderdelen van het spel er uit moeten zien. Denk bijvoorbeeld
aan tekeningen van je hoofdpersoon of van belangrijke locaties binnen je spel. Aan de hand van de
"graphic bible" zullen de verschillende zichtbare objecten en/of personages in je spel gemaakt worden.

Het laatste onderdeel dat je wilt hebben voor je daadwerkelijk begint met het spel maken is een
gedetailleerde beschrijving van het verloop van het spel: dit is een soort uitleg van hoe je van het begin
van het spel naar het eind gaat komen en welke stappen je daartussen allemaal nemen kan. Het lastige
hieraan is dat veel spellen niet lineair zijn en je dus allemaal verschillende manieren hebt om van het
begin naar het eind te komen.

Er vanuit gegaan dat je zo ver gekomen bent en het bedrijf waar je voor aan het werk bent nog steeds
vertrouwen heeft in je project, is het nu tijd om daadwerkelijk het spel te gaan maken. Een van de
eerste dingen om te doen is uitzoeken of het nuttig is om al bestaande pakketten om spellen te bouwen
te gebruiken voor bepaalde onderdelen van het spel, of dat je alles helemaal zelf nieuw bouwt. Hoeveel
tijd zelf bouwen kost is hierbij vooral erg relevant, maar ook de kosten tellen natuurlijk hard mee. Voor
het demonstratiespel dat we getoond hebben bij deze masterclass is bijvoorbeeld de editor van Half-Life
2 gebruikt. Deze editor laat je je eigen levels in elkaar zetten, laat je objecten bouwen en regelt dingen
als licht en geluid voor je. Zelf dit alles bouwen was zeker geen optie aangezien het project dan vele
malen langer had geduurd. De laatste tijd komen er veel spellen uit die je dit soort mogelijkheden
geven, al zijn ze niet allemaal zo uitgebreid als die van Half-Life 2.
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Als je besloten hebt hoe alles gemaakt gaat worden dan is het voor je programmeurs tijd om te gaan
programmeren en kan je grafisch ontwerper aan de gang met het maken van plaatjes en modellen voor
in je spel. Zelf leid je het project in goede banen en werk je mee aan de onderdelen waar je kunt.

Na een tijd van hard werken ben je klaar en kan het spel uitgebracht worden. Het is hierbij zaak om het
onder de aandacht te krijgen en dan te hopen dat mensen het leuk vinden en het kopen. Jouw taak zit
erop en hopelijk heb je een hit te pakken!

Op de VU kun je vakken volgen zoals Visual Design, Multimedia Design Casus, Human Computer
Interaction en meer. Deze vakken leren je verschillende belangrijke vaardigheden die aan de basis staan
voor het ontwerpen van interactieve programma's zoals spellen. Visual Design leert je (nadenken over)
visueel ontwerpen. Bij de Multimedia Design Casus leer je een 3D wereld bouwen en bij Human
Computer Interaction leer je over interface design, zeg maar het ontwerpen van het deel wat de
gebruiker ziet.

(Natuurlijk is dit een versimpelde weergave van alles wat hierbij komt kijken.)

HUISWERK VOOR LES 2

Volgende les is het de bedoeling dat je zelf aan de gang gaat met het toevoegen van plaatjes in een 3D
omgeving. Om dit te doen moet je natuurlijk wel wat plaatjes mee hebben. Probeer of je plaatjes van de
volgende dingen kunt vinden:

e Plaatjes van een materiaal, bijvoorbeeld hout of metaal.
e Plaatjes van posters.
e Plaatjes van een bekende omgeving, bijvoorbeeld je kamer of school.

Deze plaatjes moeten in het jpg formaat zijn en moeten één van de volgende 3 afmetingen hebben: 128
x 128 pixels, 256 x 256 pixels of 512 x 512 pixels.
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LES 2: ZELF AAN DE GANG MET EEN HALF-LIFE 2 MAP

VOORBEREIDING

Op de computers waar de deelnemers de masterclass gaan volgen staat het volgende vooraf
geinstalleerd:

e Half-Life 2 en Steam (In “D:\Program Files\Steam\”).

e  VU-Life 2 mod (In “D:\Program Files\Steam\SteamApps\SourceMods\”).
e  VTFEdit (In “C:\Program Files\VTFEdit\").

e Een grafisch tekenprogramma.

Bovendien hebben alle deelnemers alvast mee (optioneel):
e Plaatjes van materiaal (hout, metaal, etc.) in .jpg formaat.
e Plaatjes van posters in .jpg formaat.
e Foto's van een bekende omgeving/ruimte.
Eventueel kunnen de deelnemers tijdens de masterclass zelf nog naar plaatjes zoeken op het Internet.

ZELF AAN DE SLAG

Nu is het tijd om zelf aan de slag te gaan. Hiervoor is een simpele masterclass-omgeving gebouwd, deze
gaan we nu eerst bekijken. Kies voor de optie Masterclass nadat VU-Life 2 is opgestart.

,,..,.m;mwml”““
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Zoals je ziet is de omgeving vrij leeg en simpel. Dit is om je genoeg ruimte tot uitbreiding te geven en om
de compile tijd laag te houden. Compilen is het proces waarbij het level speelklaar maakt. Meer hierover
wordt verteld wanneer we met de Hammer editor van Half-Life 2 aan de slag gaan.

Wat je nu gaat doen is het aanpassen van textures, oftewel, de afbeeldingen die op de oppervlakken van
de objecten in de omgeving zitten. Voor we hiermee aan de slag gaan, eerst een kleine uitleg over het
soort afbeeldingen dat Half-Life 2 voor textures gebruikt.

HET CONVERTEREN VAN TEXTURES

Half-Life 2 en de hierop gebaseerde mods gebruiken een speciaal formaat om textures op te slaan. Voor
elke texture zijn er twee bestanden nodig: het .vtf bestand en het .vmt bestand. Het eerstgenoemde is
de texture zelf en het laatstgenoemde is een tekstbestandje waarin onder andere staat beschreven wat
het voor texture is en waar het zich bevindt.

Het is mogelijk om een willekeurig .jpg plaatje om te zetten naar het vtf bestand. Er is echter één
voorwaarde: de plaatjes moeten 128 pixels x 128 pixels, 256 pixels x 256 pixels of 512 pixel x 512 pixels
zijn. Houd hier rekening mee voordat je begint met converteren.
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Het startscherm van VTFedit.

Voor de conversie maak je gebruik van VTFEdit. Je kan je eigen jpg file laden door op “File -> Import” te
klikken. Nadat je het plaatje hebt geselecteerd krijg je een optie scherm. Klik hier gewoon op OK. Het
.vtf bestand kan dan gegenereerd worden door naar “File -> Save” te gaan. Het andere bestand (.vmt)
kan je genereren door te gaan naar “Tools -> Create VMT file”. Onder het tabblad "options" kan je bij
"Surface 1" ook nog aangeven hoe de texture zich moet gedragen (bijvoorbeeld als metaal). Druk op
create en selecteer de locatie en naam.
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Elk oppervlak dat je met deze texture bekleedt, zal zich gedragen als metaal.

SAMENVATTING

e Zorg dat je plaatje van het juiste formaat is (128x128, 256x256 of 512x512).
e  Start VTFEdit

e Kies “File -> Import” en selecteer je jpg file.

e  Druk op OK bij option scherm.

Kies “File -> Save As” om .vtf te genereren.

Kies “Tools -> Create VMT file” om .vmt te genereren.

Geef onder “Surface 1” in tabblad “Options” het gedrag van de texture aan.
Druk op “Create”.

TEXTURES AANPASSEN IN DE MASTERCLASSOMGEVING

Nu je de masterclassomgeving hebt gezien en weet hoe je textures kunt converteren is het tijd om
daadwerkelijk textures te gaan aanpassen. In de omgeving heb je verschillende objecten gezien die elk
een texture hebben. Door nieuwe textures onder dezelfde naam op te slaan zullen deze in het spel
vervangen worden. De volgende textures zijn aanpasbaar in het spel door nieuwe textures op te slaan
onder de volgende namen:

e bord_boven
e bord_onder

e posterl
e poster2
e poster3
e raam

De textures bevinden zich in de map "VU-Life 2/materials/masterclass/". Probeer nu een aantal textures
te vervangen en (her)start VU-Life 2 om het resultaat te kunnen zien. Gebruik de afbeeldingen die je
meegenomen hebt of zoek nieuwe afbeeldingen op Internet.
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HET UITERLIJK VAN EEN MODEL AANPASSEN

Zoals je misschien al gezien hebt, staat er een ninja in het masterclass level. Het uiterlijk van deze ninja
kan, net als van alle andere objecten, aangepast worden. Alleen gaat het bij een model iets anders.

In de VU-Life 2 map zit een NinjaSkin-map. Hierin zit een voorgemaakte .jpg van het uiterlijk (de skin)
van de ninja. Open deze in je favoriete graphics programma en je zult zien dat het een andere opbouw
heeft dan de andere textures. Het is aan jou om de juiste indeling te vinden. Waar moet je wat
aanpassen? Waar zitten de mond, ogen, handen, schoenen, etc? Probeer verschillende dingen aan te
passen op verschillende plekken om hier achter te komen.

T—
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Hmm... waar is zijn mond nou gebleven?
Om je nieuw gemaakte skin te testen, doe je het volgende:

e Open VTFEdit en importeer de ninja-skin.

e Sla deze vervolgens op in de directory VU-Life 2\materials\ninja als bestandsnaam nskingr.vtf.

e Maak geen .vmt bestand aan! Het .vmt bestand dat al aanwezig is, hoeft niet vervangen te
worden.

e  (Her)start nu VU-Life 2 en bekijk je ninja.

Als je er eenmaal achter bent gekomen waar je de lichaamsdelen kan aanpassen, dan kun je verder gaan
met het toevoegen van objecten aan de map in de officiéle editor: Hammer.
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HAMMER OPSTARTEN

We gaan nu aan de slag met de editor van Half-Life 2, Hommer. Om Hammer op te starten moet je het
volgende doen:

e Dubbelklik op het Steam icoontje ﬁ rechtsonder in de taakbalk. Je krijgt nu 5 tabbladen te
zien: Store, Community, My games, My media en Tools.

e Onder Tools staat Source SDK. Dubbelklik hierop om het te starten. Na wat geduld te hebben
gehad krijg je het Source SDK scherm.

e Bovenaan het Source SDK scherm zie je Applications staan met daar meteen onder Hammer
Editor. Dubbelklik hierop om de editor te starten. Na nog wat geduld te hebben gehad kom je in
de editor.

WERKEN IN HAMMER

Om aan de slag te kunnen met het masterclass level zul je deze eerst moeten openen. Ga naar “File ->
Open...” en open dan "masterclass.vmf", wat te vinden is in "VU-Life 2\maps\".
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Zo zou het geopende masterclass level eruit moeten zien.

Nu iets over de lay-out van Hammer: Links vind je een balk met icoontjes die de basisfunctionaliteiten
van de editor bevatten. In het midden heb je vier vensters: linksboven het camerabeeld, daarin zou je al
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iets van de omgeving moeten kunnen herkennen. Rechtsboven een bovenaanzicht, linksonder een
vooraanzicht en rechtsonder een zijaanzicht.

In de verschillende aanzichten kun je de balken aan de zij- en onderkant en de pijltjestoetsen gebruiken
om het beeld te verschuiven en het scrollwieltje om in- of uit te zoomen. In het camerabeeld kun je de
camera verplaatsen met W, A, S en D en draaien met de pijltjestoetsen. De muis heeft dezelfde
functionaliteit als de pijltjestoetsen nadat je Z ingedrukt hebt. (Plaats de cursor altijd in het venster
waarin je wilt bewegen.) Probeer het even uit om aan de besturing te wennen. Als je opeens een blauw
vierkant met “skybox” ziet in een zwarte omgeving ben je buiten de rand van de omgeving gegaan,
beweeg dan weer door de skybox heen naar binnen en je zult de omgeving weer zien.

lets anders wat belangrijk is, is het aanpassen van het rooster van de 2D-aanzichten. Het verslepen en
uitrekken van objecten past zich aan dit rooster aan. Voor detailwerk zal dus een klein rooster nodig zijn
terwijl voor het recht naast elkaar zetten van grote objecten een groter rooster handig is. Het rooster
kan je verkleinen met [ en vergroten met ]. Probeer het maar uit. Als je het rooster te klein maakt kan
het zijn dat het opeens weer groter lijkt te worden. De hokjes zijn dan te klein om weer te geven, zoom
in met het scrollwiel en je zult zien dat het rooster wel degelijk verkleind is.

EEN OBJECT MAKEN

Nu Hammer geopend is en je kunt rondkijken in de verschillende aanzichten kun je een simpel object
gaan maken, laten we beginnen met een eenvoudig bankje. Begin door links in beeld op de Block Tool te
klikken (het witte kubusje). Rechts in beeld verschijnt vervolgens een lijst waarin je onder Object
verschillende basisobjecten kunt selecteren. Standaard staat deze op block en dit is goed. Klik
vervolgens ergens in het bovenaanzicht en sleep de muis, je ziet nu een vierkantje ontstaan. Maak een
vierkantje van 1 roosterblokje groot. Je ziet nu maten verschijnen bij de zijden van het blokje, zoals 32.0
of 128.0. We beginnen met het maken van de “poten” van het bankje (2 betonnen blokken, daarop
komen dan een stel houten planken). Een goede afmeting voor zo’n poot is 24 bij 8 met een hoogte van
24. Waarschijnlijk moet je het rooster verkleinen om deze grootte te kunnen maken, gebruik hier [ en ]
voor. Verklein het rooster en versleep vervolgens één van de hoekpunten van het vierkant om deze
grootte aan te passen. Waarschijnlijk zul je ook even in moeten zoomen met behulp van het scrollwiel.
Herhaal dit proces tot je in het bovenaanzicht de afmetingen 24 en 8 hebt. (In welke richtingen maakt
niet zoveel uit, het bankje kan verschillende kanten op gedraaid zijn.)

Nu moet de hoogte nog aangepast worden. Gebruik hiervoor het voor- of zijaanzicht. Een hoogte van 24
moet goed zijn. Ook zal het bankje op de goede hoogte moeten worden geplaatst. Doe dit door in het
midden te klikken van het blokje en het vervolgens omhoog of omlaag te slepen. Zorg dat de onderkant
op dezelfde lijn staat als het poppetje met info_player_start boven zijn hoofd. Je kunt de hoogte ook
controleren in het camerabeeld. (Het blok is hier te zien als een figuur van witte stippellijntjes.)

Nu het blok de juiste vorm heeft is het tijd om het van een stel stippellijntjes te veranderen in een
daadwerkelijk object. Klik met je rechtermuisknop op het vierkantje in één van de 2D-aanzichten en
vervolgens op Create Object. De lijntjes worden nu rood en in het camerabeeld zie je een echt object
verschijnen met een rode gloed. Dit geeft aan dat het object geselecteerd is.

Door deze gloed heen is dezelfde texture als die van de grond te zien, baksteen. Dit is natuurlijk niet de
bedoeling en daarom gaan we dit nu veranderen.

(G)
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Rechts in beeld zie je een afbeelding van de texture met een knop “Browse...” ernaast. Klik hierop en er
verschijnt een enorme lijst met textures waar je in kunt zoeken. Om je dit zoeken te besparen heeft
Hammer een aantal handige opties. Type “concrete” achter Filter en de lijst wordt beperkt tot alleen
textures met “concrete” in de naam. Gebruik de balk rechts om door de textures te scrollen, het
scrollwiel werkt niet en kan ervoor zorgen dat het veld achter Filter weer leeg raakt. Zoek een passende
betonnen texture voor de poten en dubbelklik vervolgens op deze afbeelding, waarna het venster weer
sluit. Rechts zie je nu de nieuwe texture afgebeeld.

Om deze texture aan het object te geven moet nog één ding gebeuren. Zorg eerst dat het blok
geselecteerd is. Doe dit door eerst linksboven op de Selection Tool te klikken (het pijltje, het bovensten
icoontje) en vervolgens op het blok, wat nu rood-geel gestreept is in de 2D-aanzichten en ook weer de
vierkantjes aan de rand heeft, waarmee je de maten eventueel nog aan kunt passen. Klik daarna links in
beeld op Apply Current Texture (het kubusje van bakstenen). Dit geeft de huidige texture aan de
geselecteerde objecten, je kunt dit ook zien veranderen.

Nu moet er een tweede poot gemaakt worden, dit zou natuurlijk kunnen door het hele proces weer te
herhalen, maar gelukkig is er een makkelijkere manier voor. Je kunt een object kopiéren door Shift
ingedrukt te houden en vervolgens het object te verslepen. Plaats het tweede blok op een afstand die je
goed lijkt voor een bankje.

Nu het zitvlak nog. Maak hiervoor een blok op dezelfde manier als je met de eerste poot gedaan hebt.
Maak het 2 hoog, zorg dat het bovenop de poten komt te staan en zorg dat het naar de zijkanten 2
uitsteekt. Pas vervolgens weer de texture aan door ditmaal op “wood” te filteren. Niet alle textures
hiervan zijn even geschikt, “woodwall009a” geeft wel een mooi resultaat.

Om het effect te kunnen zien zal de omgeving, in tegenstelling tot het aanpassen van textures, eerst
opslaan (“File” -> Save of Ctrl + S) en dan gecompiled moeten worden.

COMPILEN

Druk op F9 om het compile menu te openen. Compilen gebeurt in drie stappen:

e Run BSP maakt het level
e  Run VIS rekent uit hoe het level moet worden weergegeven
e  Run RAD bepaalt de belichting

Normaal gesproken moet je altijd alle drie de stappen uitvoeren (door “Normal” te selecteren). Soms
kan het echter handig zijn (en sneller!) als je de Run RAD niet uitvoert (door “No” te selecteren). Dit
komt vooral van pas als je level complex in elkaar steekt en je een of meerdere lichtbronnen hebt
gebruikt. Alhoewel je level dan geen geavanceerde lichteffecten weergeeft, kan het behoorlijk in
compile tijd schelen. Het is daarom altijd aan te raden om lichteffecten pas op het laatst toe te voegen
wanneer je level af is.
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Het compile menu.

EEN MODEL PLAATSEN

Hammer bevat ook standaardobjecten, modellen genaamd, die je kant-en-klaar in je omgeving kunt
plaatsen.

Modellen kunnen geplaats worden met de Entity Creation Tool (boven het witte blokje). Klik hierop,
zoek vervolgens rechts in beeld onder Objects de naam prop_physics op. Klik dan op een plaats in het
camera beeld en er zal een rood blokje verschijnen. Klik op de Selection Tool (linksboven) en dubbelklik
vervolgens op het blokje wat je net geplaatst hebt. Er verschijnt nu een nieuw venster met
eigenschappen van het model. Ga naar World Model en klik op Browse... Er verschijnt weer een nieuw
venster en in dit venster kun je een model kiezen. Linksboven vind je een lijst met mappen waarin
modellen staan. Daaronder staat een lijst van modellen in de map die op dat moment geselecteerd is en
rechtsboven kan je een voorbeeld van het model zien. (Je kunt de camera hierin draaien om het model
beter te kunnen bekijken.)

Ga nu naar de map props_junk en zoek een model uit wat in de omgeving past. De meeste modellen in
deze map kun je als speler verschuiven of oppakken. (Je kunt dit controleren door rechtsonder op Info te
klikken en te kijken of physics aangevinkt is.) Klik nu op OK, dan op Apply in het andere venster en sluit
vervolgens ook dit venster af. Verschuif het model zodat het op de grond komt te liggen/staan. Sla de
gemaakt wijzingen op en druk weer op F9 en OK om het level te compilen en het resultaat te bekijken.

EEN EFFECT AANPASSEN

In de spelomgeving staat een “adresbord”, zoals je deze op de VU aantreft. In het klimaatlevel, dat je in
de eerste les hebt gezien, “waait” dit bord omver in de storm. In deze omgeving blijft het bord zoals je
waarschijnlijk al gemerkt zult hebben gewoon staan. Daar gaat nu wat aan veranderen.

Even een kleine uitleg van hoe het omvallen in zijn werk gaat: Om het bord zie je een geel doorzichtig
blok met “trigger” op de grond. Dit is een proximity trigger die de nabijheid van de speler (maar ook van
andere objecten) in de gaten houdt en vervolgens andere dingen kan activeren. Het bord zelf is een
deur die open en dicht draaien (of algemener: kantelen) kan.
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Op dit moment is de proximity trigger inactief, waardoor er nog niks gebeurd is tijdens eerdere
opdrachten. Om dit te veranderen moet je nu op de trigger dubbelklikken in het camerabeeld. Zoek
vervolgens start disabled op in de lijst die verschijnt en verander dit van “yes” in “no”. Als je bovenaan
op Outputs klikt kun je zien dat de trigger al verbonden is aan de deur. Klik op Apply om de
veranderingen toe te passen en sluit daarna het venster. Sla je wijzigingen op en druk op F9 en
vervolgens “OK” om het level te compilen. Na het compilen start je het masterclass level en loop naar
het adresbord toe om het effect te zien.

Zoals je zult merken kloppen er een aantal dingen nog niet aan het effect. Het bord beweegt, maar de
verkeerde kant op en het gaat ook erg langzaam. Er moeten dan ook twee dingen veranderen:

De richting van de draaiing moet worden aangepast. Dubbelklik op het bord, er zal nu een zelfde soort
venster verschijnen als bij de proximity trigger. Klik bovenaan op flags, hier staan een aantal opties die je
kunt aanvinken, waaronder X Axis en Y Axis. De deur draait standaard om de Z as, dat is de verticale as,
zoals je ook van een deur zou verwachten. Nu is dit echter niet het geval, de bovenkant van het bord
moet naar beneden, hiervoor moet X Axis worden aangevinkt.

0ok de snelheid van de val moet worden aangepast. Ga terug naar Class Info, zoek Speed op in de lijst
en verhoog de snelheid. Klik op Apply voor je het venster sluit en test het effect tot je tevreden bent
over de snelheid.

lets waar je misschien nog niet tevreden over bent is dat de val wat onrealistisch lijkt omdat de deur
met een constante snelheid beweegt. Probeer om de realiteit te vergroten een fiets tegen het bord te
plaatsen, zodat het bord hier op valt. Doe dit door een model te plaatsen op de manier die je eerder
gebruikt hebt. De fiets is te vinden onder props_junk. Je zult zien dat dit er een stuk beter uit ziet.
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LES 3: HET MAKEN VAN EFFECTEN

In deze les wordt uitgelegd hoe verschillende effecten kunnen worden gemaakt in een level met behulp
van Hammer. Deze effecten zijn gebruikt in het klimaatlevel uit de eerste les. Je kunt het klimaatlevel
bekijken door VU-Life 2 op te starten en te kiezen voor de optie “Betreed de VU campus”. Probeer één
of meerdere van de beschreven effecten zelf te maken of verzin een nieuw effect!

HET VALLENDE BORD

Voor het vallende bord zijn twee entities gebruikt: Een proximity trigger, die ervoor zorgt dat het bord
valt wanneer de speler in de buurt komt, en een draaibare deur.

Maak eerst een bord of iets anders wat moet vallen. Maak nu een andere brush en pas dan de “Origin”
texture erop toe. Groepeer je object en de origin brush door alle brushes te selecteren (Ctrl + klikken) en
druk dan Ctrl + T om ze te groeperen. Deze groep wordt nu beschouwd als één brush, met als
middelpunt het middelpunt van de originele brush. Het bord zal draaien om dit middelpunt, dus de
volgende stap is het plaatsen van de origin brush op zo een manier zodat het bord draait om het juiste
punt. In dit geval zou de origin brush een beetje boven de grond moeten zijn, zodat het lijkt alsof het op
de vloer terecht komt. Merk op dat de grootte van de origin brush niet uitmaakt, het gaat allemaal om
het middelpunt ervan.

Gebruik nu “Tie to Entity” (rechtsklikken op de brush) om het te veranderen in een
“func_door_rotating”. Dit is een entity type dat normaal gesproken inderdaad wordt gebruikt voor
draaiende deuren (het andere deurtype wordt gebruikt voor schuifdeuren).

Geef de entity nu een naam (de proximity trigger zal gaan verwijzen naar deze naam), bijvoorbeeld
“signpost” of iets anders dat makkelijk te herkennen is.

Je kunt de hoek van het object veranderen zodat het niet helemaal horizontaal komt te liggen. Om dit te
doen, gebruik je “Distance”. Als je object de verkeerde manier valt, gebruik dan een negatief getal.

Gebruik “Start Sound” en “Stop Sound” om het geheel realistischer te maken. Het juiste geluid vinden
kan wat tijd kosten, kijk een beetje rond.

Verander “Delay Before Reset” naar “-1” om te voorkomen dat het object weer overeind komt.

Klik nu op “Apply” en ga naar de “Flags”. Afhankelijk van je oriéntatie in je wereld moet je kiezen voor of
de X-as of de Y-as flag (de standaard as is Z). Als je niet zeker weet welke as je moet gebruiken, probeer
dan een van ze.

Om het geheel te triggeren, maak je een andere brush, dat het gebied om jouw bord beslaat. Geeft deze
brush de “Trigger” texture. Zodra de speler dit gebied binnenkomt, wordt de “func_door_rotating”
getriggerd, dus pas de grootte aan om dit te doen. Gebruik “Tie to Entity” en verander de brush in een
trigger_proximity”.

Verander “Point to Measure From” naar het object dat je zojuist hebt gemaakt. Vervolgens verander je
“Radius to measure within” naar een waarde die groter is dan de maximum afstand van het object naar
de rand van de trigger brush.
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Om het triggeren mogelijk te maken, moeten we kijken naar de “Outputs”. Klik op “Add...”, verander
“My output named” naar “OnStartTouch” en de “target entity” moet natuurlijk de naam zijn van jouw
bordobject. “Via this input” moet veranderd worden naar “open”. Klik tenslotte op “Apply” en je bent
klaar.

Start je level en kijk hoe het eruit ziet/klinkt. Je kunt eventueel de snelheid een beetje veranderen, de
hoek kleiner maken, de origin texture veranderen (met Ctrl + W of het ig icoon op je scherm) of je kunt
de grootte van de trigger brush aanpassen.

VLIEGENDE DAKDELEN

De delen van het dak die eraf vliegen zijn gemaakt met behulp van de eerder beschreven mechanismen.
Zoals bij het vallende bord maak je een proximity trigger en een draaiende deur. Deze keer begint de
deur horizontaal en beweegt omhoog met een aanzienlijk hogere snelheid. Dit wordt mogelijk gemaakt
door de “nodraw” texture, die het onzichtbaar maakt zodat het onder een dakdeel naar keus kan
worden geplaatst, zodat het als een katapult functioneert. Het deel van het dak dat je lanceert is een
“func_physbox” en moet niet te zwaar zijn in verband met katapulten met wat toegevoegde wind.

Het deel van het dak moet balanceren op wat muren of iets wat voorkomt dat het valt. Roteer het met
via een “Transform” (Ctrl + M) of dubbelklik erop in één van de twee 2D vensters. Je kunt ook brushes
met “nodraw” textures gebruiken om te voorkomen dat het dak valt.

Experimenteer met de snelheid, positie en hoek van de katapult om het gewenste effect te bereiken. Als
je wil kun je een extra “trigger_push” gebruiken (deze zal nogal wat kracht nodig hebben) om de delen
nog verder te blazen als ze eenmaal in de lucht zijn.

WATER

Water maken is heel makkelijk met Hammer. Maak een brush van de juiste grootte en pas een van de
water textures erop toe. Om het water te laten stijgen zoals in het klimaatlevel, gebruik je “Tie to Entity”
en maak je van de brush een “func_water_analog”. De meeste opties spreken voor zich. Gebruik
“Speed” en “Move Distance” om de juiste hoeveelheid verandering binnen de juiste tijd te krijgen en
verander “Move Direction” naar de gewenste waarde (-90 0 0 is omhoog). Vergeet niet dat je de water
brush moet uitrekken met de groottes die je wilt dat het beweegt. Stop het niet waar de muren of de
vloer begint, anders ziet het er slecht uit. Maak de water brush voor de zekerheid wat groter. Hierna
moet je een trigger maken (bijvoorbeeld een knop) die ervoor zorgt dat het effect wordt getriggerd via
zijn output.

WINDEFFECTEN

Het principe voor het maken van wind is eenvoudig, maar het precies goed krijgen vereist veel
fijnafstemming en uitproberen.

Om wind te maken, teken je een brush over het gebied waar de wind moeten waaien. Geef het een
trigger texture en rechtsklik erop in één van de 2D views. Klik vervolgens op “Tie to Entity”. Verander de
entity naar een “trigger_wind” en geef het een duidelijke naam. Er zijn verschillende parameters die je
kunt manipuleren, maar kijk eerst naar de flags en vink de dingen aan die moeten worden beinvloed
door de wind (om objecten te kunnen duwen, vink je “Clients” af en vink je “Pushables”, Physics
Objects” en “Physics debris” aan). Ga dan terug naar de parameters.
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Begin met de parameters aan te passen door de richting te kiezen (Pitch Yaw Roll), het veranderen van
de YZX waarden (meestal Z) om de juiste richting te krijgen. Het puntje naast “Angles” kan worden
gebruikt om te bepalen wat de juiste richting is en komt overeen met de oriéntatie van de top view.

Vervolgens kun je de snelheid aanpassen van de objecten die je wilt duwen. Het is het makkelijkstje om
eerst objecten te maken (zie paragraaf Duwbaren objecten). Geef ze de juiste grootte en pas dan de
windsnelheid hierop aan. Het is heel moeilijk om wind te maken die objecten van verschillende groottes
kan wegblazen op een realistische manier (alhoewel je dit zou kunnen bereiken door de “Mass Scale”
van de verschillende objecten aan te passen). Probeer het uit en wees niet bang om veranderingen te
maken van 40 tot 400, zodat je ziet wat er gebeurd. Hier nog wat tips:

Als je

e Als je net beneden de juiste snelheid zit, kunnen objecten heel langzaam de andere kant
opschuiven. Laat dit je niet verwarren.

e In het klimaatlevel is de wind brush een foot groot, wat ervoor zorgt dat hogere snelheiden
kunnen worden bereikt, zonder dat objecten de hele tijd door de lucht vliegen.

e Alle objecten zullen in één richting worden geduwd en zullen uiteindelijk tegen een muur
aankomen of het einde van de trigger brush. Objecten die tegen de muur aanliggen zien er
slecht uit, houdt hier rekening mee wanneer je het einde van je brush bepaalt. Experimenteer
met verschillende wind entities in verschillende richtingen voor betere effecten.

e Erzijn een aantal “Noise” parameters, die zorgen voor variatie in richting en snelheid. Gebruik
ze om het realisme te vergroten.

Je kunt de wind entity activeren met een proximity trigger, zoals beschreven is in de voorgaande
paragrafen. In dit geval, zet je “Start Disabled” op “Yes” voor “trigger_wind”. Vergeet niet om op
“Apply” te klikken voordat je het venster afsluit.

TEKSTBOODSCHAP

Voor tekstboodschappen kun je de “game_text” entity gebruiken. Klik op het “Entity Tool” icoon aan de
linkerkant en selecteer “game_text” als object aan de rechterkant. Klik nu ergens in de camera view om
de entity toe te voegen. De plaats is niet belangrijk, voeg het op een voor jouw logische plek toe.
Dubbelklik nu op de entity, wat ervoor zorgt dat het “Tie to Entiy” venster wordt geopend. Geef de
entity vervolgens een naam. Je ziet verschillende paramters zoasl “Hold Time”, “Fade in Time”, position
on the screen, etc. die makkelijk zijn om aan te passen. Het lastige deel is de boodschap zelf. De
boodschap kan worden ingetikt in het “Message Text” veld, maar zal op slechts één regel worden
weergegeven. Het makkelijkste is om nu voor elke regel tekst een nieuw “game_text” entity te maken
en ze onder elkaar te positioneren. Merk op dat tekstboodschappen gebruik maken van tekstkanalen,
waarvan er vier aanwezig zijn en slechts een kanaal kan tegelijkertijd worden gebruikt. Oftewel, je kunt
meerdere kanalen gebruiken om verschillende regels weer te geven die elkaar opvolgen over tijd. Door
een trigger naar keuze aan de “game_text” te koppelen, kun je bepalen wanneer de tekst moet
verschijnen.

DUWBARE OBJECTEN

Om een duwbaar object te maken, maak je een brush, rechtsklik je erop in één van de 2D views, klik je
op “Tie to Entity”, verander je het in een “func_physbox” en klik je tenslotte op “Apply”.
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Een andere manier is om een duwbaar object te verkrijgen is een model te gebruiken, dat al duwbaar is.
In de volgende paragraaf wordt beschreven hoe je deze duwbare modellen kunt plaatsen.

Gewicht van de objecten hangt af van de grootte, de texture en kan ook worden beinvloed door de
“Mass Scale” parameter.

HET PLAATSEN VAN DUWBARE MODELLEN

Duwbare modellen kunnen worden toegevoegd dooreen “props_physics” entity te maken met de
“Entity Creation Tool”. Selecteer “prop_physics” aan de rechterkant en klik dan ergens in de camera
view om het te plaatsen. Druk op de “Selection Tool” en dubbelklik op het rode blok dat is verschenen.

d

Ga naar “World Model” en klik op “Browse..”. Een nieuw scherm wordt geopend. Aan de
linkerbovenkant zie je een lijst van mappen die modellen bevatten. Daarbeneden is een lijst van
modellen in de geselecteerde map. “Props_junk” bevat een aantal handige objecten om afval te
plaatsen. Je kunt het model aan de rechterbovenkant zien. Het kan ook worden geroteerd zodat je het
beter kunt zien. Rechtsonder staat informatie over het weergegeven model, waaronder of het duwbaar
is. Objecten met “physics” enabled zijn duwbaar. Wanneer je hebt gevonden wat je zoekt, druk “OK” en

dan “Apply”. Vergeet niet om je object op de juiste plek te zetten.
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RESOURCES

Game @ VU -- www.cs.vu.nl/~eliens/game

Documentatie -- www.cs.vu.nl/~eliens/game/masterclass.pdf
Masterclass -- www.cs.vu.nl/~eliens/multimedia/game.html
Project pagina -- www.few.vu.nl/~vugame

Game Development -- www.cs.vu.nl/~eliens/design/game.html
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